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Overview
This guide is designed to assist district technical staff in:

•	 preparing data for loading into IEPWriter and the Children Count module (see the Data Preloading section).This 
includes your school’s student, guardian, staff, building, roster, district bank and IEP/ER data. Formatted data samples 
are included in this guide for further assistance in preparing data for import. Penn Data Exceptionality Codes are also 
included for reference.

	 The Data Preloading section directs you to one of the following appendices:

•	 IEPWriter Users

•	 Children Count Module/Dual User (School Age)

•	 Children Count Module

•	 submitting prepared data to Leader Services through Leader’s secure Uploads website (see the Client File Upload sec-
tion).

•	 ensuring proper browser settings for district users, which should be done before they use IEPWriter (see the System 
Requirements section).

The IEPWriter.com administrator or technical staff responsible for setting up your school’s IEPWriter system retains the option 
of manual setup of IEPWriter and Children Count data. Please refer to the IEPWriter.com User Guide for more information on 
manual setup.

System Requirements
For a complete list of system requirements, as well as recommended browsers, settings, and free plug-ins, visit the 
IEPWriter.com System Requirements page at:

https://www.iepwriter.com/pa/SystemRequirements.aspx

IP Addresses and Ports

You must allow HTTP and HTTPS traffic for ports 80 and 443 on your school’s proxy server/firewall. The following IP addresses 
should be allowed through your proxy server/firewall:

•	 12.44.224.16

•	 74.43.14.144
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Data Preloading
Leader provides your district with the option of preloading data into IEPWriter and Children Count. Of course, you can load 
data manually using the pages within IEPWriter and Children Count.

If your LEA purchased:

•	 Only IEPWriter: please see the IEPWriter Users Only section.

•	 The Children Count Module only or both IEPWriter and the Children Count Module: please see the Children Count or 
Dual Users section.

•	 Only Early Intervention: see the Early Intervention Students section.

IEPWriter Only

To preload your district’s data into IEPWriter:

1.	 See Appendix A for a list of acceptable IEPWriter files.

2.	 Format your district’s data for one or more of these files (see Figures A and B).

3.	 Save your district’s data in an acceptable file format (see the File Format section).

4.	 Upload the file(s) using Leader’s Client File Upload Site (see the Client Files Upload Site section).

Note: School-age and gifted student files do not have to be submitted in separate student files. Student type is determined by grade and exceptional-
ity. If a student’s exceptionality is specified as gifted without disability, then the student is loaded as a gifted student.

Children Count or Dual Users

If your district is using Children Count only or both Children Count and IEPWriter, you need only to prepare data for Children 
Count. Leader will then take that data and preload it into IEPWriter, if applicable. This procedure is followed since the Children 
Count module gathers more data types than IEPWriter, including all IEPWriter data types. 

Note: School-age students must be submitted in separate student files. Please include gifted students in the school-age student file.

To preload your district’s data into IEPWriter:

1.	 See Appendix B for a list of acceptable Children Count files.

2.	 Format your district’s data for one or more of these files (see Figures A and B).

3.	 Save your LEA’s data in an acceptable file format (see the File Format section).

4.	 Upload the file(s) using Leader’s Client File Upload Site (see the Client Files Upload Site section).

Note: Student type is determined by exceptionality. If a student’s exceptionality is specified as Gifted without Disability, then the student is loaded as a 
gifted student.
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Formatted Samples
Submit all data to Leader in the comma-separated value (CSV) format, created by saving and exporting files from most spread-
sheet and database programs.

Figure A was formatted in Microsoft Excel, a comma-separated value (CSV) format. The information in this example follows the 
order as described in Appendix A for the District Goal/Objective Bank File.

Figure B: Roster file

Figure A: District Goal/Objective Bank file

Figure B follows the order as described in Appendix A.

Please do not include column headers in the file. The header row, if left intact, will show up as errors when you run the data 
through IEPWriter’s Import File Validator Program (see the Import File Validator Program section for more information).
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File Format
Submit all data to Leader in the comma-separated value (CSV) format using the Save As feature in your spreadsheet program 
or Export feature in your database program.

Save a spreadsheet in the CSV file format  
(spreadsheet program)

Export a spreadsheet in the as CSV file format  
(database program)

1.	 Select the Save As feature in your spreadsheet 
program.

2.	 Select the CSV file format from the Save As Type 
drop-down menu.

3.	 If you have the options of CSV for Macintosh or 
CSV for MS-DOS, select the CSV for MS-DOS file 
format.

4.	 Save the data with a new filename.

1.	 Select the Export feature in your database pro-
gram. 

2.	 Select the database table that you want to export 
and select Export.

3.	 Choose the comma as the delimiter and do not 
include the field names on the first row. 

4.	 In the Export dialog box, select the CSV file for-
mat from the Save As Type drop-down menu.

5.	 Save the data with a new filename.

Import File Validator Program
Before sending your CSV file to Leader for preload, run IEPWriter’s Import File Validator Program. This program was developed 
to catch file formatting errors before your data reaches Leader. Download the program at:

http://www.iepwriter.com/about/validator.aspx

1.	 Launch IEPWriter’s Import File Validator program by double-clicking its program icon.

2.	 Click Open File. Navigate to and open the file you want to test. Remember that the file must be saved as a CSV file.

3.	 Select the appropriate radio button under the Select which System the Import File is for heading. A list of types related 
to your selection will display; click the appropriate radio button under the Select the type of Import file heading.

4.	 Click Validate File.  A message will display indicating whether errors were found in the file. Click OK. If no errors were 
found, click Exit to close the application or proceed to the next file you want to validate. If errors were found, do one 
of the following:

•	 Click View Error File to display the errors found in the file. You can optionally save the error file from this screen to 
a comma-separated text file.

•	 Click Save Error File to save the file to your computer as a comma-separated text file. Open the file in Microsoft 
Excel or a text editor like Notepad to view the errors.

Correct any errors that were identified before submitting files to Leader for processing. 
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Common Errors
A table of common errors follows. If you find an error(s), make corrections to your original file, re-convert the file to CSV, and 
run it through the validator again until it doesn’t have any errors. 

Commas in 
your data:

The most common error is caused by having commas in your data. For example, if you 
have a last name formatted as:

Jones, Jr.
change it to:

Jones Jr.
before you convert your file to a CSV.

 
Leading 
zeros:

 
If you have a CSV file and open it in Excel (by double-clicking it, or using File > Open 
in Excel), you will probably lose the leading zeros in your data (for example, 00201 turns 
into 201). To avoid this problem:
Edit the CSV file using Notepad (right-click the CSV file, choose Open with…, and select 
Notepad); or
Open Excel. Click on Data > Import External Data > Import Data (in Excel 2007, click 
on Data > From Text). Navigate to and select the CSV file. A Text Import Wizard will 
open. 
Step 1: Select Delimited and click Next. 
Step 2: Under Delimiters, select Comma and click Next. 
Step 3: Click on each column, then click the Text radio button.
Click Finish. Remember to Save As a CSV file when you’re done making corrections.



A division of LDP Inc.
6

Technical Information Guide 

Error Messages

Legend:

[fieldname] = the name of the field shown on the error file.

[number] = On the error file, you will see the specific number within the field.

Error Message Meaning Solution

[fieldname] is a required field. This field must have information in it. Enter the appropriate information for that 
field.

Maximum length of [fieldname] 
[number] exceeded.

This field can have only [number] of char-
acters in it.

Check the field on that line and remove 
any additional characters.

[fieldname] is not a valid field in 
the appendix.

The information in this field doesn’t match 
what it should be according to the codes in 
the Appendix of the technical guide.

Change the value in this field to match the 
appropriate code according to the Appen-
dix.

[fieldname] is not a valid date. The information in this field is not format-
ted in the proper date format.

Correct the entry to conform to the date 
format as required in the Appendix.

[fieldname] is not a valid num-
ber.

This field needs to have information for-
matted as a number.

Reformat or change the information to a 
number.

[fieldname] must be either Y or 
N.

This field requires a Yes or No answer, 
formatted as Y or N.

Change the information to reflect the 
requirement.

The file has [number] fields per 
line; this line of the CSV file has 
[number] fields.

The file is supposed to have only X num-
ber of fields per line; this line has too little 
or too many.

The most common cause for this error is 
that there is a comma in one of the fields 
on that line; remove it.

Exit Reason is a required field 
when the Exit Date exists.

This line contains an exit date, but no exit 
reason.

Add the exit reason, according to the Ap-
pendix.

Teacher Assignment is a 
Required field when Related 
Service Provider is Y.

Related Service provider is Yes on this line, 
but there is no Teacher Assignment.

Add the teacher assignment, according to 
the Appendix.

End date must be on or after the 
Begin date.

Related service start date is after the end 
date. Correct the dates on this line.

Withdraw Date must be on or 
after the Entry Date. The withdraw date is before the entry date. Correct the dates on this line.

Once you’ve verified your file format and corrected all errors, transfer the data to Leader for preload.
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Client File Upload Site
Leader developed a secure web site for the submission of data files (Figure C), which is protected by Secure Socket Layer (SSL) 
encryption. To obtain a username/password for the site, e-mail Leader Services at: uploads@leaderservices.com

Alternately, you may submit data file(s) on a CD. Leader will not preload data submitted on paper unless arrangements have 
been made to use our data-entry services.

Figure C: Client File Upload Site

For the latest system requirements for the Client Upload Site, visit 

https://apps.leaderservices.com/_uploads/systemrequirements.aspx

Navigate to the Upload Site and Upload a File(s)

1.	 Type the following address into your web browser’s address or location bar and press the Enter key:

http://www.leaderservices.com/uploads

2.	 Enter your username and password in the fields provided and click Submit.

3.	 Select a related file from your local computer by clicking the Browse… button and selecting a file type.

4.	 Choose the type of file. This will automatically notify the proper staff at Leader when your file is submitted.

5.	 You may enter additional information in the Note to Leader field. Then click Upload to begin the upload process.

Note: You are limited to submitting files that are less than 10Mb in size. For files over this size, please contact Leader at (800) 360-8511 or e-
mail uploads@leaderservices.com for instructions.
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After you finish uploading, click Log out to close your session and exit the site. You may enter additional information 
about the file in the Note to Leader field. Then click Upload to begin the upload process.

After you finish uploading, click Log out to close your session and exit the site.

Contacting Leader
If you are mailing your LEA’s data files, please use one of the following addresses:

US Postal Service:

Leader Services

Attn: IEPWriter Support

PO Box O

Hazleton, PA 18201

Other Shippers (UPS/FedEx):

Leader Services

Attn: IEPWriter Support

75 Kiwanis Boulevard

West Hazleton, PA 18202

For technical assistance or more information on preloading your school’s data, call our Help Desk at 877. 456.8777 
weekdays from 8 AM-6 PM or e-mail helpdesk@leaderservices.com
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Appendix A – Formatting Data for IEPWriter
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide

Student File Guardian File
Column Headers:
Student ID*
PA Secure ID
First Name*
Middle Initial
Last Name*
Gender* (M or F)
Date of Birth* (mm/dd/yyyy format)
Grade*¹
Graduation Year*
Student Email
Home District* (AUN)
Building Name
Building Location Code (4-digit State code)
Primary Exceptionality*¹
Secondary Exceptionality¹
Ethnicity*¹
Status*¹
Exit/Inactive Date
Exit Reason¹
MA Eligible (Y or N)
MA Number
ESL (Y or N)
Migrant (Y or N)
Delimiter (Enter * to denote end of record)*

Save as: STUFILE.CSV or STUFILE.TXT

Column Headers:
Student ID*
Salutation
Guardian First Name*
Guardian Last Name*
Parent/Guardian Type¹
Address1*
Address2
City*
State*
County
Postal Code*
Home Phone
Work Phone
Cell Phone
Home Email
Work Email
Primary Guardian* (Y or N)
Display Guardian Name/Address on IEP (Y or 
N)
Delimiter (Enter * to denote end of record)* 

Save as: GUARDIAN.CSV or GUARDIAN.TXT
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Staff File Building File
Column Headers:
Last Name*
First Name*
Title*
Phone
Fax
Email
Building Name
Building Location Code (4-digit State code)
IEPWriter User (Y or N)
Delimiter (Enter * to denote end of record)*

Save as: STAFF.CSV or STAFF.TXT

Column Headers:
Building Name*
Building Location Code* (4-digit State code)
Address1
Address2
City
State
ZIP
Phone
Fax
Email
Building Principal
Start Time
End Time
Vo-tech (Y or N)
Delimiter (Enter * to denote end of record)*

Save as: BUILDING.CSV or BUILDING.TXT

Student Roster File District Goal/Objective Bank File
Column Headers:
Student ID*
Staff Last Name*
Staff First Name*
Type* (IEP Case Manager, Contributor,  Evalua-
tion, View-only)
Delimiter (Enter * to denote end of record)*

Save as: ROSTER.CSV or  ROSTER.TXT

Column Headers:
Goal Subject*
Sub-Category
Goal Level
Type* (Goal or Objective)
Description
Delimiter (Enter * to denote end of record)*

Save as: GOALOBJ.CSV or GOALOBJ.TXT

Appendix A – Formatting Data for IEPWriter
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide
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Appendix A – Formatting Data for IEPWriter
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide

2 Exit Date only required if child exited special education. Exit Reason only required if Exit Date exists

Compliance Dates File
Column Headers:
Student ID*
Active Date*
Inactive Date
IEP Meeting/Conference Date
IEP Implementation Date
IEP Duration Date
Date of Last IEP Revision
Initial Eval Date
Reevaluation Date
Delimiter (Enter * to denote end of record)*

Save as: IEPER.CSV  or IEPER.TXT
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Appendix B – Formatting School Age/Gifted Data for Children 
Count and Dual Users
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide

2 Exit Date only required if child exited special education. Exit Reason only required if Exit Date exists

Student File Staff File
Column Headers:
Student ID*
PA Secure ID
First Name*
Middle Initial
Last Name*
Gender* (M or F)
Date of Birth* (mm/dd/yyyy format)
Grade*¹
Graduation Year
Student Email
Home District* (AUN)
Building Name
Building Location Code (4-digit State code)
Primary Exceptionality*¹
Secondary Exceptionality¹
Status*¹ 
Exit Date*2

Exit Reason*¹ 2

Primary Teacher (Staff ID)
Ethnicity* ¹
MA Eligible (Y or N)
MA Number
Transition*¹ (multiple values allowed separated 
by semicolons)
Special Ed. Entry Date (mm/dd/yyyy)
Referral Date (mm/dd/yyyy)
Transition Plan Date (mm/dd/yyyy)
Limited English Proficient (Y or N)
Migrant (Y or N) 
Delimiter (Enter * to denote end of record)*

Save as: STUFILE.CSV or STUFILE.TXT

Column Headers:
Staff ID*
First Name*
Last Name*
Middle Initial
Ethnicity¹
Special Education Teacher* (Y or N)
Related Service Provider* (Y or N)
Paraprofessional* (Y or N)
Highly Qualified* (Y or N)
Teacher Assignment*¹ (only required if Special 
Education Teacher = Y)
Other Special Ed¹ (only required if Related Ser-
vice Provider = Y)
Children Served*¹
Provider¹
Location of Intervention¹
Fully Certified (Y or N)
Gifted Teacher (Y or N)
Include Staff in Fed/State Reporting (Y or N)
FTE* (9.99; use FTE of 0 if you don’t want the 
staff member to be counted for PennData pur-
poses)
Active Date*
Inactive Date
Delimiter (Enter * to denote end of record)*

Save as: STAFF.CSV or STAFF.TXT
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Unilateral Removal Suspensions
Column Headers:
Student ID*
Removal Date*
Reason for Removal*¹
Number of Days Removed*
Delimiter (Enter * to denote end of record)*

Save as: UNILAT.CSV or UNILAT.TXT

Column Headers:
Student ID*
Suspension Start Date*
Number of Days Suspended*
Type Suspension*¹
Delimiter (Enter * to denote end of record)*

Save as: SUSPEN.CSV or SUSPEN.TXT

Expulsions
Column Headers:
Student ID*
Expulsion Start Date*
Received Educ. Services (Y or N)*
Number of Days Expelled*
Delimiter (Enter * to denote end of record)*

Save as: EXPULSION.CSV or EXPULSION.TXT

Appendix B – Formatting School Age/Gifted Data for Children 
Count and Dual Users
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide
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Appendix B – Formatting School Age/Gifted Data for Children 
Count and Dual Users
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide

Assignments Compliance Dates
Column Headers:
Student ID*
Active Date*
Inactive Date* (only required if assignment is 
inactive)
Assignment Code*¹
Major Assignment* (Y or N)
Type of Service/Amount of Special Ed.*¹
Provider¹
Building Name*
Building Location Code* (4-digit State code)
Serving District* (AUN)
Home District* (AUN)
Primary Exceptionality*¹
Secondary Exceptionality¹
Teacher (Staff ID)*
Residence Status*¹
LRE/Educational Environment*¹ (Required for 
students educated in regular buildings with non-
disabled students)
LRE Pct./Educational Environment Pct.*
Funding Eligibility*¹
Neighborhood School*¹
Integration District (AUN)
Dually Enrolled (Y or N)
Delimiter (Enter * to denote end of record)*

Save as: ASSIGN.CSV OR ASSIGN.TXT

Column Headers:
Student ID*
Active Date*
Inactive Date
IEP Meeting/Conference Date
IEP Implementation Date
IEP Duration Date
Date of Last IEP Revision
Initial Eval Date
Reevaluation Date
Date Perm. To Eval Requested by Parent
Date Received Permission to Evaluate
Date Received Permission to Reevaluate
Date Received Invitation to Participate Response
Date Received Consent to Excuse Members
Date Received NOREP Response
Date Received Reevaluation Waiver
Reevaluation Waived Date
NOREP Date
Permission to Evaluate Date
Permission to Reevaluate Date
Services Plan Date
Initial Eval Found to be Eligible (Y or N)
Initial Eval Completed in Timeline (Y or N)
Reevaluation Found to be Eligible (Y or N)
Special Reason Initial Eval not Completed¹
Non-Compliance Reason
Delimiter (Enter * to denote end of record)*

 Save as: COMPLIANCE.CSV or COMPLIANCE.
TXT

Note: If a student has an IEP Meeting/Conference Date, IEP 
Implementation Date, Evaluation, Reevaluation and 
NOREP dates, these fields are required.
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Related Service	 Building File
Column Headers:
Student ID*
Related Service* ¹
Provider¹
Funding Source¹
Teacher Name (Staff ID)
Location
Start Date*
End Date*
Frequency
Times Per Frequency
Length Of Service (Minutes)
Delimiter (Enter * to denote end of record)*

	Save as: RSRVC.CSV or RSRVC.TXT

Column Headers:
Building Name*
Building Location Code* (4-digit State code)
Address1
Address2
City
State
ZIP
Phone
Fax
Email
Delimiter (Enter * to denote end of record)*

	 Save as: BUILDING.CSV or BUILDING.TXT

Appendix B – Formatting School Age/Gifted Data for Children 
Count and Dual Users
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide
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Student Address	
Column Headers:
Student ID*
Salutation
Guardian First Name*
Guardian Last Name*
Parent/Guardian Type¹
Address1*
Address2
City*
State*
County
Postal Code*
Home Phone
Work Phone
Cell Phone
Home Email
Work Email
Primary Guardian* (Y or N)
Display Guardian Name/Address on IEP (Y or 
N)
Delimiter (Enter * to denote end of record)*

Save as: ADDRESS STUFILE.CSV or AD-
DRESS.TXT

Appendix B – Formatting School Age/Gifted Data for Children 
Count and Dual Users
* Denotes required fields
¹ Refer to Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Assignment Code 01 Learning Support

02 Life Skills Support
03 Multiple Disabilities Support
04 Emotional Support
06 Deaf or Hearing Impaired Support
07 Speech and Language Support
08 Physical Support
10 Blind or Visually Impaired Support
11 Gifted Support
26 Autistic Support
16 Preschool Home Based
17 Preschool Classroom Based
18 Preschool Combination
27 Preschool/Non-classroom
28 Preschool Community Based
29 Preschool/Inclusive
30 Preschool Intensive Classroom Based

Children Served (Staff) 01 Children Ages 3-5
02 Children Ages 6-21

Delimiter * Denotes the end of the current record

Ethnicity (Student Demo & Staff 
Demo)

01 American Indian/Alaskan Native

03 Black or African American

04 Hispanic
05 White
06 Multiracial
09 Asian
10 Native Hawaiian or Other Pacific Islander

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Exit Reason 01 Graduated with Regular High School Diploma

02 Received GED and/or Certificate (Correctional Facilities and 
Facilities for Adjudicated Youth only)

03 Reached Maximum Age

04 Dropped Out

05 Transferred to Regular Education

06 Moved, Known to be continuing

09 Deceased

10 Child transitioned to school age (SA), known to be continuing

11 Child transitioned to school age (SA), not known to be continuing

12 Child exiting preschool prior to school age: no longer needs special 
education

13 Child exited preschool special education upon turning school age: 
no longer needs special 

Funding Eligibility 0 IDEA
1 Chapter 15 (504)
2 Not Yet Determined

Funding Source X Not Eligible
9 Gifted Only
A
B
C
E

Education
Welfare
Health
Other

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Grade PS Pre School

KF Kindergarten Full Day
KH Kindergarten Half Day
01 First Grade
02 Second Grade
03 Third Grade
04 Fourth Grade
05 Fifth Grade
06 Sixth Grade
07 Seventh Grade
08 Eighth Grade
09 Ninth Grade
10 Tenth Grade
11 Eleventh Grade
12 Twelfth Grade

LRE/Educational Environment 
School Age

(Blank) Gifted without Disability

1 Approved Private School (Non Residential)

2 Approved Private School (Residential)

5 Public Separate Facility (Residential)

6 Other Private Facility (Residential)

9 Hospital/Home Bound

12 Public Separate Facility (Non Residential)

14 Out of State Facility

15 Instruction in the Home

16 Other Private Separate Facility (Non Residential)

18 Correctional Facility

19 Inside the regular class 80% or more of the day

20 Inside regular class no more than 79% of day and no less than 40% of 
the day

21 Inside the regular classless than 40 percent of the day

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Location of Intervention for 
Assignments & Staff

01 Public School

02 Special Education Center

03 Family Child Care

04 Regular Nursery School

06 Approved Private School/Residential

07 Head Start

09 Hospital

14 Out-of-State Facility

15 In-Home

16 Approved Private School/Day

17 Residential Facility

Neighborhood School (Blank) Gifted without Disability

01 Student attending neighborhood school

02 Student NOT attending neighborhood school – Required Special 
Education Support and Services

03 Student NOT attending neighborhood school – Other Reasons

Non-Compliance Reason P Parental Reason

A Administrative

E For SLD Extension allowed under Federal Regulation 34 CFR 
300.309

Other Special Ed and Related 
Services (Staff)

2
3

19
25
54
56
57
A1
A2
A3

A5

Medical/Nursing Service Staff
Orientation and Mobility Specialists
Social Workers
Psychologists
Speech-Language Pathologists
Occupational Therapists
Physical Therapists
Audiologists
Interpreters
Physical Education Teachers and Recreation and Therapeutic Rec. 
Specialists
Counselors and Rehabilitation Counselors

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Primary Exceptionality 2121 Autism

2122 Deaf-Blindness

2134 Developmental Delay

2127 Emotional Disturbance

2123 Hearing Impairment including Deafness

2124 Mental Retardation

2125 Multiple Disabilities

2126 Orthopedic Impairment

2132 Other Health Impairment

2128 Specific Learning Disability

2129 Speech or Language Impairment

2130 Traumatic Brain Injury

2131 Visual Impairment incl. Blindness

Provider (Related Services & Staff) A School District

B Intermediate Unit

D Head Start

E MH/MR Program

F Public Health Center

G Private Practitioner

H Hospital

I Clinical

K Other

Reason Date Received
Parent Consent is Blank 01 Parent Withdrawal

02 Parent Choice
03 Parent/Child Moved
04 Child exited 0-3 Program Prior to Transition Meeting

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Reason ER Not Within 60 Days of 
Parent Permission 02 Withdrawal

04 Agency Difficulties

05 Parent Choice

06 Parent/Child Unavailable
07 Parent/Child Moved

Reason for Removal 01 Weapon Offense – Removed by School Personnel

02 Drug Offense – Removed by School Personnel
03 Likely Injury – Determined by Hearing Officer

04 Serious Bodily Injury – Removed by School Personnel

Related Service 01 Transportation

02 Audiological Services

03 Psychological Services

04 Physical Therapy

05 Occupational Therapy

06 Counseling Services

07 School Health Services

08 Social Work Services

09 Parent Counseling, Training

10 Speech and Language Pathology/Therapy

11 Adaptive Physical Education

12 Behavior Intervention Program

13 Assistive Technology Devices and Services

14 Rehabilitation Counseling

15 Interpreter

16 Orientation and Mobility

17 Mental Health Services provided by other than IU/SD

18 Other

Residence Status (Blank) Resident

01 Ward of State

02 1302 – Living with Adult other than Parent

05 1305 – Foster Child

06 1306 – Institutionalized Child

Appendix C – Penn DATA Code Reference Guide
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Category Code Description
Secondary Exceptionality 2121 Autism

2122 Deaf-Blindness

2127 Emotional Disturbance

2106 Gifted with Disability

2123 Hearing Impairment including Deafness

2124 Mental Retardation

2125 Multiple Disabilities

2126 Orthopedic Impairment

2132 Other Health Impairment

2128 Specific Learning Disability

2129 Speech or Language Impairment

2130 Traumatic Brain Injury

2131 Visual Impairment incl. Blindness

Special Reason Initial Evaluation not 
Completed

1 Parent fails to produce child for evaluation

2 Enrolls in another school prior to determination
Status 0 Inactive

1 Active
2 In Process
3 Not Eligible
4 Screened, not in need of evaluation

Transition (Blank) Less than 14 or 16, depending on the date of the IEP, or Gifted 
without Disability

01 Post Secondary Education and Training Goal

02 Employment Goal
03 Independent Living Goal, if Appropriate

Type of Parent 01 Birth

02 Legal Guardian

03 Custodial
04 Foster

05 Non-Custodial
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Category Code Description
Type of Service 01 Itinerant

04 Full-Time

05 Gifted
06 Supplemental

Type Suspension 01 In School
02 Out of School

Teacher Assignment 1 Speech impaired certified
2 Hearing impaired certified

3 Visually impaired certified
4 Comprehensive certified
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